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Experiment HP-14: Hypothesis-driven Biofeedback Lab/Research Study

What is Biofeedback?

Biofeedback is a technique that people can use to learn to control their body's physiological functions. 

The definition of biofeedback states: a process that enables an individual to learn how to change 

physiological activity for the purposes of improving health, performance, and eliminating anxiety or 

stress. Physiology recording instruments are used to measure the body’s activity such as brainwaves, 

heart function, breathing depth and rate, muscle activity, skin temperature and more. These instruments 

“feed back” information to the subject via images or values. This information, often in conjunction 

with changes in thinking, emotions, and behavior helps support the desired physiological changes. 

A better and easier definition of biofeedback is that it is the process of gaining greater awareness of the 

body’s physiological functions primarily using instruments that provide information about those 

systems, with the goal of being able to alter them at will.

How does it work?

With biofeedback, the subject will be connected to sensors that help receive information about the 

subject’s body. This feedback helps the individual focus on making subtle changes, such as relaxing 

certain muscles, to achieve the wanted results, such as reducing pain. Biofeedback gives people the 

power of their thoughts to control their body’s activities and is often used as a relaxation technique.  It 

appeals to many people for a variety of reasons; it is non-invasive, painless and can even eliminate the 

use of certain medications.

During a biofeedback session electrical sensors monitor the body's physiological state, such as brain 

waves, skin temperature or muscle tension. This information is fed back to the subject via cues, such as

a beeping sound, a flashing light, or even just watching the data recorded change in real time. The 

feedback teaches individuals to change or control their body's physiological reactions by changing 

thoughts, emotions or behavior. A typical biofeedback session can last from 30 to 60 minutes. 

Biofeedback techniques can include:

• Electromyography (EMG) biofeedback which gives information about muscle tension to learn 

relaxation.

• Temperature (thermal) biofeedback allows an individual to see a drop in body temperature due 

to stress and start relaxation techniques.

• Galvanic skin response training which measure the activity of sweat glands and the amount of 

perspiration on the skin, alerting you to anxiety.

• Heart rate biofeedback which enables control of heart rate in an effort to improve blood 

pressure, lung function, and reduce stress and anxiety.

This lab is meant to be a “hypothesis-driven” lab where students will come up with a technique or 

techniques they would like their subject to try in order to alter some aspect of the subject’s 

physiological parameters. This can include: reducing heart rate, sweating, altering body temperature 

and/or breathing rate.  The settings file for this lab is currently set up to record: ECG, Pulse, Skin 

Conductance, Blood Pressure, Respiration, Body Temperature, Heart Rate and Breathing Rate.  

Parameters can be added or removed based on what the goal of the hypothesis is.
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Biofeedback Suggestions:

Note: All suggestions and techniques should be fully researched first to gain an understanding of 

the effect(s) it may have on your subject.  

Hypotheses and techniques MUST be approved by the instructor prior to any experimentation.  

It is also important to make sure the technique is applied and used properly.

• Deep breathing

• Yogic breathing

• Repetitive statements (“I am not cold”, “I am not scared”, “I am warm on a sunny beach”, etc...)

• Imagery (Note: images can up uploaded to the settings file using “Sequences”)

• Progressive muscle relaxation

• Guided imagery and meditation

Experimental Suggestions:

• Subject is anxious after watching scary video clips.  Use techniques that would allow the 

subject to reduce their anxiety levels.

• Subject is warmed using a blanket; use techniques for cooling body temperature.

• Subject is cold; use techniques for warming body temperature.

• Subject is tense after being given a hard test (try the “Stroop Effect” or hard oral math 

questions). Use techniques that would relax muscle tension.

Experiment HP-14: Hypothesis-driven Biofeedback Lab/Research Study

Equipment Required

PC or Mac Computer

IXTA data acquisition unit and power supply

USB cable

*iWire-B3G GSR amplifier and electrodes

*iWire-B3G ECG electrodes

*PT-104 Pulse plethysmograph

*BP-220 Non-invasive blood pressure transducer & BT-220 Black tygon tubing with Luer connectors

*RM-204 Respiration Monitor

*TM-220 Temperature Sensor
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**Note: adding or removing sensors for this experiment is left open-ended.  As many parameters as 

the hypothesis is looking at can be measured.

As an example – the iWire-B3G EMG electrodes can be added to record muscle activity as well.

Extra items such as: blankets, a variety of feeling producing images, ice packs, paper bags, etc... 

may be needed depending on the hypothesis.

IXTA Setup

1. Place the IXTA on the bench, close to the computer.

2. Check Figure T-1-1 in the Tutorial Chapter for the location of the USB port and the power 

socket on the IXTA.

3. Check Figure T-1-2 in the Tutorial Chapter for a picture of the IXTA power supply.

4. Use the USB cable to connect the computer to the USB port on the rear panel of the IXTA. 

5. Plug the power supply for the IXTA into the electrical outlet. Insert the plug on the end of the 

power supply cable into the labeled socket on the rear of the IXTA. Use the power switch to 

turn on the unit. Confirm that the power light is on.

Start the Software

1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is 

not available, click on the Windows Start menu, move the cursor to All Programs and then to 

the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window 

will appear as the program opens.

2. On the Main window, pull down the Settings menu and select Load Group.

3. Locate the folder that contains the settings group, IPLMv6Complete.iwxgrp. Select this group 

and click Open.

4. Pull down the Settings menu again. Select the Biofeedback settings file in the Human 

Psychophysiology folder.

5. After a short time, LabScribe will appear on the computer screen as configured by the 

Biofeedback settings.

6. For your information, the settings used to configure the LabScribe software and the IXTA unit 

for this experiment are programmed on the Preferences Dialog window which can be viewed by

selecting Preferences from the Edit menu on the LabScribe Main window.

7. Once the settings file has been loaded, click the Experiment button on the toolbar to open any 

of the following documents:

• Appendix

• Background

• Labs

• Setup (opens automatically)
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Sensor Setup

Note: Connect the iWire-B3G to the IXTA prior to turning it on.

1. Locate the PT-104 pulse plethysmograph and plug it into the Channel A5 input of the IXTA 

(Figure HP-14-S1).

• Place the pulse sensor on the volar surface of the subject’s thumb.

• Note: If also recording Blood Pressure, make sure the pulse sensor in on the same limb.

2. Locate the iWire-B3G ECG and Galvanic Skin Response amplifier and GSR electrodes (Figure 

HP-14-S2) in the iWorx kit.  

• Attach the purple and orange GSR electrodes to the correct connectors on the iWire-

B3G.

• Note – the GSR unit is precalibrated.  No other calibration is needed.

• Attach the GSR electrodes to the pointer and ring finger of the subject's hand.  Make 

sure the fingers are not too cold or too dry.

• Attach the black, red, and green electrodes to the correct connectors on the same iWire-

B3G.

3. Use an alcohol swab to clean and scrub a region with little or no hair, on the inside of the 

subject’s right wrist/clavicle. Let the area dry.

4. Remove a disposable ECG electrode from its plastic shield, and apply the electrode to the 

scrubbed area on the wrist/clavicle.

5. Repeat Steps 3 and 4 for the inside of the left wrist/clavicle and the inside of the right ankle. 

Snap the lead wires onto the electrodes, so that:

• the red (+1) lead is attached to the left wrist or under the left clavicle,

• the black (-1) lead is connected to the right wrist or under the right clavicle,

• the green (C or ground) lead is connected to the right leg or on the abdomen.

Figure HP-14-S1: PT-104 pulse plethysmograph.
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Figure HP-14-S2 The iWire-B3G ECG and Galvanic Skin Response amplifier.  The purple and orange 

GSR electrodes are shown in this image.

6. Locate the BP-220 non-invasive blood pressure (NIBP) transducer (Figure HP-14-S3).

• Plug the tubing connector of the BP-220 into the channel labeled A2 on the front of the 

IXTA.

7. Locate the TM-220 temperature sensor and plug the connector on the end into the channel 

labeled “Temp” on the front of the IXTA unit.  The temperature sensor can be placed on the 

back of the subject's hand, on the forehead, or any other location.  Carefully secure it in place 

with a small piece of paper tape.

• Note: The TM-220 temperature probe is precalibrated and additional calibration is 

not necessary.  Using the a 2-point calibration and the “Units Advanced” feature will 

allow you to calibrate if you would like to perform another calibration.

8. Locate the RM-204 respiration monitor and plug the connector into channel A6 on the front of 

the IXTA unit (Figure HP-14-S4).  The RM-204 

• Wrap the elastic belt of the respiration monitor around the subject’s chest at a level that 

is below the sternum. Place the sensor inside the belt so that the sensor is in the center of

chest at a level that is even with the subject’s elbows.

• If the subjects are sitting during these exercises, they should sit erect so that the muscles 

involved in pulmonary ventilation are able to move with few restrictions.

• Stop the experiment if the subject feels dizzy or nauseated.
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Figure HP-14-S3: BP-220 blood pressure sensor and extension tubing; and the TM-220 temperature 

probe.

Figure HP-14-S4: RM-204 respiration monitor belt.

Calibration of the Non-Invasive Blood Pressure Transducer

Procedure

1. Lay the cuff of the BP-220 on the lab table. 

2. Click on the Record button, located on the upper right side of the LabScribe Main window 

(Figure HP-14-S5). The signal should begin scrolling across the screen.

Figure HP-14-S5:  LabScribe3 Toolbar
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Note: If the user clicks the Record button and there is no communication between the iWorx unit and 

computer, an error window will appear in the center of the Main window. Make sure the iWorx unit is 

turned on and connected to the USB port of the computer. Click OK and select the Find Hardware 

function from the LabScribe Tools menu. 

3. Click on the AutoScale button at the upper margin of the Blood Pressure channels.  

4. Record data while the cuff is laying on the table for about 10 seconds. 

5. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 

in which to save the file, like your lab group folder. Designate the file type as *.iwxdata. Click 

on the Save button to save the data file.

6. On the units conversion window, put a check mark in the box next to Apply units to all blocks. 

Enter “0” in the box:  Set Mean Value between Cursors to:. Click on the OK button in the lower

right corner of the window to activate the units conversion.

Figure HC-1-S6: The Units Offset dialogue window with the mean values set to “0”.

Figure HP-14-S6: The IXTA with the PT-104 and TM-220 plugged into the correct channels.
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• The iWire-B3G for GSR and ECG will be plugged into the iWire 1 port.

• The BP-220 and tygon tubing will be connected to the black A2 port.

• The RM-204 will be plugged into channel A6 (next to the PT-104).

Experiment HP-14: Hypothesis-driven Biofeedback Lab/Research Study

This lab is meant to be a “hypothesis-driven” lab where students will come up with a technique or 

techniques they would like their subject to try in order to alter some aspect of the subject’s 

physiological parameters. This can include: reducing heart rate, changing skin conductance, altering 

body temperature and/or breathing rate.  The settings file for this lab is currently set up to record: ECG,

Pulse, Skin Conductance, Blood Pressure, Respiration, Body Temperature, Heart Rate and Breathing 

Rate.  Parameters can be added or removed based on what the goal of the hypothesis is.

Sample Exercise: Measuring Galvanic Skin Response and Body Temperature Before and After 

Imagery

Aim: To measure the subject’s skin conductance and body temperature before and after looking at 

“cold” feeling/producing imagery.

Procedure

1. Select one person from your group to be the subject. Ask the subject to go to the sink, wash his 

or her hands with soap and water, and dry them thoroughly. Washing the hands insures that 

surface oils or other substances, which might lower skin conduction, are removed. Do not use 

alcohol to clean the fingers, alcohol dehydrates the skin.

2. Connect the GSR electrodes as stated in the set up document.

3. Connect the temperature sensor as well.

4. Attach each GSR electrode to the volar surface of the distal finger segment of two non-adjacent 

fingers; the index and the ring fingers are the ones usually used. Attach the electrodes with the 

Velcro straps so that the straps are snug, but not overly tight.  You may need to slightly moisten 

the finger tips for good conduction.

5. Attach the temperature sensor to the back of the subject's hand with a small piece of paper tape.

6. The subject should rest his or her hand with the sensors attached comfortably. The GSR 

electrodes should be free from any extraneous pressure and the electrode cable should be 

hanging freely. Instruct the subject not to move the hand during the recording process; 

movement may introduce artifacts into the recording. 

7. Click on the Record button. Enter the subject's name in the Mark box and press the Enter key on

the keyboard. Since the GSR amplifier is already calibrated, the value displayed on the Skin 

Conductance Level channel is the baseline skin conductance level (SCL) of the subject (Figure 

HP-14-L1). Record the subject’s baseline SCL for approximately one minute until the recording

stabilizes.

8. Click Stop to halt the recording. 
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9. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 

in which to save the file, like your lab group folder. Designate the file type as *.iwxdata. Click 

on the Save button to save the data file. 

10. Wrap the subject in a warm blanket and let the subject sit and get “warm.”  Ask the subject 

when he or she begins to feel a bit “sweaty.”  Do not allow the subject to get uncomfortable.

Figure HP-14-L1: Sample data showing skin conductance only.  Other channels will show based on 

the hypothesis and settings chosen for the lab/research project.

9. Click on the Record button. Record the subject’s baseline “warmed”  skin temperature for one 

minute. 

10. Continue recording.

11. Begin showing your subject images of “cold” feeling/producing images.  These images can be 

imported and built into the “Sequences” option under Edit => Preferences.  Refer to the iWorx

Help manual for more information.

12. Show each image for approximately 5 seconds. Have the subject concentrate on each image, 

while thinking “cooling” thoughts and that his or her body temperature is decreasing.  

13. Continue recording until you see a noticeable change in skin conductance and/or body 

temperature.  Record no longer than 30 minutes.

Note: If, at any time, the subject gets uncomfortable being wrapped in the blanket, remove the 

blanket and stop the experiment.

14. Click on the Save button to save the data file. 

15. Repeat this exercise on other subjects in your lab group.

Data Analysis 

1. Scroll through the data file and locate the recording of the subject’s baseline skin conductance 

level (SCL). 
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2. Use the Display Time icons to adjust the Display Time of the Main window to display the one 

minute recording of the subject’s baseline SCL on the Main window. This section of data can 

also be selected by:

• Placing the cursors on either side of the one minute recording of the subject’s SCL, and

• Clicking the Zoom between Cursors button on the LabScribe toolbar (Figure HP-14-L2) 

to expand or contract the one minute recording to the width of the Main window.

3. On the right hand margin of the Skin Conductance channel, the mathematical function, Mean, 

should appear. The value for mean baseline skin conductance level is displayed here. 

Figure HP-14-L2: The LabScribe toolbar. 

4. Once the cursors are placed in the correct positions for determining the mean baseline skin 

conductance level in the one minute recording, the value for the mean baseline skin 

conductance level can be recorded in the on-line notebook of LabScribe by typing the name and

value of the parameter directly into the Journal.

5. Move the cursors to the section of data where the subject's “warmed” body temperature was 

recorded.  Position the cursors to have at least 30 seconds of data on screen.

6. On the right hand margin of the Temperature channel, the mathematical function, Mean, should 

appear. The value for mean “warmed” body temperature is displayed here. 

7. Scroll through the data file and locate the recording when the subject was shown images of 

“cold” feeling/producing images. 

8. Use the Display Time icons to adjust the Display Time of the Main window to display a five 

minute section of an area near the end of the imagery recording. This section of data can also be

selected by:

• Placing the cursors on either side of a five minute section of the end of the recording, 

and

• Clicking the Zoom between Cursors button on the LabScribe toolbar (Figure HP-14-L2) 

to expand or contract the five minute recording to the width of the Main window.

9. Enter the value for the mean “cooled” skin conductance level and body temperature for the 

subject in TableHP-14-L1.

10. If other data, such as Pulse and Heart Rate are being recorded, the data can be selected and 

analyzed in the same way.
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Table HP-14-L1: Baseline SCL & Temperature vs. SCL & Temperature after Imagery

Subject’s Name
Mean Baseline

SCL (µS)

Mean “warmed”

body

temperature

(degrees C)

Mean “cooled”

SCL (µS)

Mean “cooled”

body

temperature

(degrees C)
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